)

CorelDRAW

TECHNICAL SUITE 2019

Reviewer’s Guide



CorelDRAW

TECHNICAL SUITE 2019

Contents

1 | Introducing CorelDRAW Technical Suite 2019.......ccccoovovereerenne. 1
2 | CUSTOMET PrOfIlES .o 4
3| What's INCIUAEA? ...t 5
4 | KEY fRALUIES ...ttt ssesee 7

5 | XVL Studio 3D CAD Corel Edition (optional add-on)............ 13




Introducing CorelDRAW® Technical Suite 2019

CorelDRAW® Technical Suite 2019 empowers visually
impactful technical communication. The suite lets
users design with new levels of precision thanks to a
comprehensive collection of applications, innovative
tools, and accelerated application performance all
developed with productivity in mind. Carefully crafted
for professionals and technical graphics users,
CorelDRAW Technical Suite 2019 is your all-in-one
suite for visual technical communication.

Be boundless

Whether you're creating complex user manuals,
detailed illustrations or any other kind of output that
requires technical graphics, CorelDRAW Technical
Suite 2019 delivers a comprehensive suite of
professional applications that meets all your visual
communication needs for project creation, authoring
and publishing of technical documentation.

Thanks to extensive file compatibility, users can import
and edit content from any source, publish to industry-
standards, or share with customers, business partners
or colleagues. The suite offers a greater variety of ISO-
compliant export options like PDF/X-4, which helps
ensure hassle-free output of files to the widest range
of printing devices. A redesigned Print Merge
workflow simplifies combining an illustration with
snippets of variable text to produce several different
copies of a design. And CorelDRAW Technical Suite
2019 Enterprise license users can collaborate more
easily thanks to enhanced support for Microsoft
SharePoint.

You can also rely on compliance with various
standards-based systems thanks to support for
technical publication specifications. Technical
communicators can export work to over 100 file
formats, including to S1000D (including Issue 4.2), ATA
iSpec 2200-compliant IETPs, WebCGM, SVG, as well as
3D PDF or PDF/A. You can also count on hassle-free
file exchange with colleagues and clients worldwide
and the ability to produce a range of downstream
outputs. Whether it's AutoCAD DWG and DXF, Adobe
lllustrator CS/CC, Adobe Photoshop CS/CC, Microsoft
Publisher, or Adobe Acrobat, you can access and
repurpose data from a wide range of formats.

Be precise

When it comes to visually communicating how
something is designed, assembled or operated,
accuracy is paramount. CorelDRAW Technical Suite 2019
offers a range of precise illustration and design tools
to create detailed technical documentation with exact
specifications. Technical illustrators can work with
projected drawing planes with confidence and find
drawing axes easily with enhanced projected drawing
features. Corel DESIGNER® continues to extend its
S1000D support with the introduction of standard-
compliant line style sets. And a series of new options
take the guesswork out of creating crisp, clean icons,
dashboard images, and web graphics. Adding to an
already powerful, dedicated set of precision tools,
Corel DESIGNER 2019 takes the guesswork out of
creating detailed assembly instructions, complex user
manuals, illustrated parts catalogs, and more.
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Be productive

With CorelDRAW Technical Suite 2019, you'll work
more efficiently and productively thanks to new tools
and enhancements — from the new Objects docker
that gives you direct control over the structure of a
document and quick access to its components to
performance upgrades that make this the fastest
version of the suite yet. It's easier than ever to locate
design components and update their properties, even
in the most complex files. Users can also take
advantage of a newly optimized workspace specifically
for technical illustration.

What's more, the suite has an array of professional 3D-
authoring, creative design and image editing
applications that deliver a seamless workflow, from
opening 2D and 3D source files, photos, documents
and data, to producing and publishing technical
communications.
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Choose your purchase option

In the interest of user choice, there are several
CorelDRAW Technical Suite purchase options.

Perpetual License

At Corel, we believe that you should not be forced
into a rental model if you don’t want it. For a

onetime payment, a CorelDRAW perpetual license
gives you the right to use the software forever, with no
extra monthly cost. By purchasing a box, download
version or volume license version of the product, you
get access to the full benefits of a specific version, and
there is no need for a permanent Internet connection.
With the optional Upgrade Protection Program
customers can additionally benefit from receiving
major version upgrades immediately when they
become available. There is also a volume licensing
option for companies with five or more seats — the
CorelDRAW Technical Suite Enterprise license. It
includes one-year CorelSure Maintenance, which
offers efficient multilingual software deployment and
virtualization support. It also has downgrade rights,
which cover the use of previous version with newly
added licenses.

Subscription

A CorelDRAW® Subscription is an affordable way to
stay up-to-date with the latest tools and
enhancements of CorelDRAW Technical Suite. It offers
a cost-effective alternative to paying the upfront cost
of the software. Instead, you'll get a full, downloadable
version of CorelDRAW Technical Suite* that remains
entirely functional for as long as your subscription is
active. You decide how and when you want to use it.
An annual plan offers an overall discount, with the
option to auto-renew or end your subscription after
the 12-month period. Your subscription entitles you to
the latest performance enhancements and updates. It
also entitles you to the next major version upgrade for
as long as your subscription is active.

Upgrade Protection Program

The CorelDRAW® Upgrade Protection Program is the
hassle-free way for technical illustrators and technical
graphics users to keep their toolbox up-to-date at the
best price. If you own a version of CorelDRAW
Technical Suite with a perpetual license, you pay one
affordable fee once a year, and you're assured of
working with the latest design tools, new file
compatibility, and the most current technology. And as
long as your account is active, you'll automatically get
the latest version of CorelDRAW Technical Suite. Best
of all, sign up once and forget about it. In addition, if
your needs change, you will continue to own the last
version you received through the upgrade program.
The Upgrade Protection Program is also an optional
add-on for the CoreDRAW Technical Suite Single-user
Business license.

Volume License options for teams and organizations

CorelDRAW Technical Suite can also be licensed for
single users, teams and larger groups in an
organization. The CorelIDRAW Technical Suite Single-
user Business license lets companies get individual
licenses that come with the option of adding the
Upgrade Protection Program. The CorelDRAW
Technical Suite Enterprise license allows organizations
to purchase licenses in volume to secure a much lower
overall cost. It includes one year CorelSure Software
Maintenance, which guarantees that customers
automatically receive all new releases during the
lifetime of the program, as well as benefiting from
advanced support and cumulative cost savings if
additional seats are required. What's more, this license
offers enterprises the choice of renewing CorelSure
Maintenance for one or two years. Both options are
available to order from one of our many authorized
resellers.

For more information about the Corel Licensing
program, please visit www.coreldraw.com/business.

* A corel.com account and Internet connection are required to
download and use the application and manage your
subscription.
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Customer profiles

Technical communication
professionals

These users often have formal training in a technical or
graphics field, such as technical illustration or
technical writing. They work in a range of sectors,
including discrete manufacturing, automotive,
aerospace, high tech and telecommunications,
architecture, engineering and construction (AEC), and
energy, oil and gas.

The graphics created by technical illustrators are used
in assembly instructions, user guides, illustrated parts
catalogs (IPCs), maintenance manuals, schematics, or
wiring diagrams. These documents are output to
various media, such as print, the web, mobile devices,
and interactive electronic technical manuals (IETMs).

Technical communication professionals in today’s
global markets need to create technical publications in
multiple languages for a worldwide customer base.
The ability to work seamlessly with Translation
Memory Systems (TMS) used in the localization
workflow is critical to streamline processes.

In addition, many organizations rely on content
authoring and management systems, so they seek
solutions that can be easily incorporated into their
existing processes. These users seek integrated tools
that allow them to create utilities and macros to
automate tasks and enhance their workflow.

Technical graphics users

These users are often self-taught in graphic-creation
tasks and include knowledge workers in medium to
large enterprise environments, such as manufacturing,
automotive, telecommunication, pharmaceuticals,
chemicals, and energy industries.

Among their many tasks and responsibilities is the
need to create a variety of graphics, including
diagrams used in presentation materials, floor plans,
schematics, and marketing materials.

These users may create graphics from scratch or base
them on legacy files. They often work collaboratively,
so they need direct access to Microsoft SharePoint to
quickly retrieve and store documents, compare
document versions, and track changes directly from
within their technical graphics software. The graphics
they create may later be imported for reuse with
office-productivity, diagramming, and desktop-
publishing software.

In a typical organization, there may be many technical
graphics users spread across several departments.
They are not generally required to use the software
daily, and as such, they do not often get opportunities
for extensive training.

Organizations require cost-effective and easy-to-use
solutions that enable their users to repurpose legacy
files and 2D CAD data — and eventually 3D CAD data.
They also need tools for creating basic technical
diagrams and publishing standardized outputs.
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What’s included?

Applications

Corel DESIGNER® 2019: This specialized
application streamlines the technical graphics
workflow by offering precision vector drawing,
page layout, and diagramming tools that meet
the demands of technical illustrators and technical
graphics users.

CorelDRAW® 2019: This intuitive vector-illustration
and page-layout application is the perfect partner
for Corel DESIGNER. It offers graphics users
additional creative graphics and design tools that
are ideal for more artful endeavors, such as
marketing collateral outputs.

Corel PHOTO-PAINT® 2019: This professional
image-editing application lets you quickly and
easily retouch and enhance photos for both
technical communication and creative graphics
projects.

XVL Studio Corel Edition: This 3D authoring
application lets you create vector illustrations and
photo-realistic renderings from 3D views,
including cross sections and 3D element
modifications, such as the creation of exploded
views.

Corel Font Manager™ 2019: This standalone font
management application lets you find, organize,
and preview local fonts, including fonts in a
network and regardless of being installed on the
system.

Corel® PowerTRACE® 2019: As an integrated
feature in Corel DESIGNER and CorelDRAW, this
convenient utility lets you quickly and accurately
convert bitmaps, such as scanned blueprints, into
editable vector graphics.

Corel® CAPTURE™ 2019: This one-click utility lets
you capture images from your computer screen,
which is especially useful for creating illustrated

software documentation, such as user guides.

CorelDRAW.app™: This powerful web app lets you
create, review and access designs on the go using
devices other than your computer.

Corel® AfterShot™ 3 HDR: This photo editor lets
you create high dynamic range (HDR) images and
make easy corrections and enhancements to your
RAW or JPEG photos.

BenVISTA PhotoZoom Pro 4: This plug-in lets
registered users export and enlarge digital images
from Corel PHOTO-PAINT.

Supporting applications

XVL Player: This 3D viewer is integrated with Corel
DESIGNER 2019 for the insertion of 3D data assets
in technical illustrations. It provides the ability to
modify 3D views and display modes.

Microsoft Visual Basic for Applications: This
integrated development environment lets you
create utilities and macros that interact with the
drawing page, enhance applications in the suite,
and streamline your workflow.

Microsoft Visual Studio Tools for Applications: This
toolset includes the power of the .NET framework,
so developers can create time-saving plug-ins and
add-ons with Visual Studio to automate tasks and
extend functionality.

JavaScript (JS): The integrated APl enables
developers to automate tasks and extend
functionality

Barcode wizard: This wizard lets you generate bar
codes in a wide range of industry-standard
formats.

Duplexing wizard: This wizard helps you optimize
your work for two-sided printing.

GPL Ghostscript: This feature lets you isolate and
use individual elements of imported EPS files and
improves the import of PDF files generated by
third-party applications.
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Content

*  More than 4,000 industry-standard Architectural,
Electrical, General, Mechanical, and Tools symbols

« 7,000 high-quality clipart, digital images, and
vehicle wrap templates

+ 1,000 high-resolution digital photos
«  Over 1,000 TrueType and OpenType fonts

«  More than 150 professionally designed templates,
including more than 40 technical ANSI, DIN, and
ISO standard templates

«  Over 600 fountain, vector and bitmap fills
Documentation

*  Online Help files

*  Online User Guides (PDF format)

« Video tutorials

CorelDRAW Technical Suite 2019
system requirements

+  Windows 10*, Windows 8.1 or Windows 7, in 32-bit or
64-bit, all with latest updates and service packs

« Intel Corei3/5/7 or AMD Athlon 64

« 2GBRAM

« 10.7 GB hard disk space

+  Multi-touch screen, mouse or tablet

« 1280 x 720 screen resolution at 100% (96 dpi)
»  Microsoft Internet Explorer 11 or higher

»  Microsoft .NET Framework 4.7.2

« CD drive optional (for box installation)
Installation from CD requires a download of up to
1.82 GB

» Internet connection is required to install and
authenticate CorelDRAW Technical Suite and
access some of the included software
components, online features and content. For
more information, please visit
www.coreldraw.com.

XVL Studio 3D CAD Corel Edition
(optional Add-on) system requirements

For processing 3D CAD assembly data we
recommend:

*  Windows 10* Windows 8.1 or Windows 7 (64-bit
editions) with the latest updates and service pack
installed

+ 8 GBRAM or more
« 1280 x 800 or higher screen resolution

« Internet connection required for product
activation and installing updates

XVL Studio Corel Edition is included and installed with
CorelDRAW Technical Suite 2019. The optional XVL
Studio 3D CAD Add-On product unlocks additional
functionality for the integrated application.

*Note: CorelDRAW Technical Suite 2019 supports Windows 10,
version 1803, 1809 and later versions being released during the
lifecycle of CoreDRAW Technical Suite 2019.

[ 6] Reviewer's Guide

CorelDRAW

TECHNICAL SUITE 2019


https://www.coreldraw.com

A
R

W/
\ //
w

Key features

CorelDRAW Technical Suite 2019 is a complete and cost-
effective solution for authoring visual communications
for publishing to print, online, and mobile devices.

Be boundless

Whether you're creating complex user manuals or
detailed illustrations, you will find a comprehensive
suite of professional applications to meet all of your
visual communication needs for project creation,
authoring and publishing of technical documentation.

Enhanced! Non-destructive bitmap effects:

Corel DESIGNER 2019 makes it easy to apply, modify,
and experiment with bitmap effects on both vectors
and bitmaps, all without altering the source object. The
new Effects tab in the Properties docker is the hub for
non-destructive editing. It displays a list of all effects
applied to a selected object and lets you add new
effects and delete existing ones in a couple of clicks.
What's more, you can launch an applied effect’s dialog
box from the docker and make quick adjustments.
Great when working on a vector illustration, this new
workflow allows for unlimited experimentation. You can
get different looks by reordering effects in the list or
toggling them on or off.

You can even apply a stack of effects, then create
reusable styles or style sets based on that stack. This
allows you to modify all objects to which it has been
applied by altering the effects stack once in the style
or style set definition.

This feature is also available in CorelDRAW 2019.
Click here to see how it works.

Give it a try

APPLY NON-DESTRUCTIVE BITMAP EFFECTS

1  Inthe Welcome Screen, open the Discover file
Bike Effects.

If the Welcome Screen isn't open, click Help » Welcome.

2 Inthe drawing, click on the top tube of the bicycle.

3 On the standard toolbar, set the zoom level to
400%, and use the scroll bars on the drawing
window to center the top tube and the Corel logo.

4 Press Alt+Enter to open the Properties docker,
and click the Effects tab fx

Any bitmap effects that are applied to a selected
bitmap or vector object are listed.

5 Position your cursor over Gaussian Blur in the
Bitmap Effects list, then click the Hide button (®
to see the impact of the effect. Click the button to
show the effect again.

6 Now position your cursor over the effect, and click
the Edit button 4.

This automatically displays the dialog box for the
applied effect for easy adjustments.

You can add more bitmap effects to the selected

object by clicking the Add effect button + and
choosing an effect.

Add bitmap effects to objects without altering the original.
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Enhanced! Print Merge: Corel DESIGNER 2019 has
updated the way you combine a drawing with
snippets of variable text to produce several different
copies of a design. With overhauled Ul and a
streamlined workflow, the Print Merge feature makes it
even easier to combine a graphic with a data source to
quickly generate wiring diagrams of parallel circuits,
bills of material, and more.

This enhancement is also available in CorelDRAW 2019.

Easily create multiple iterations of the same design.

Enhanced! PDF/X support: CoreDRAW Technical Suite
2019 offers a greater variety of ISO-compliant PDF/X
export options. New support for PDF/X-4 helps
ensure easy output of files that are compatible with
the widest range of devices and compliant with the
latest print-industry standards.

This enhancement is also available in CorelDRAW 2019.

Enhanced! Transform docker: The Transform docker
lets you experiment with transformations without
affecting the original object. You can transform objects
with precision and apply the transformation to the
duplicate of an object, which is created automatically.
Clearer labels, improved layout, and new interactive
controls make the Transform docker easier to use. And
in Corel DESIGNER 2019, a new option lets you fit an
object into a rectangular area that you specify.

Enhanced! Microsoft SharePoint support: Users with a
CorelDRAW Technical Suite 2019 Enterprise license
(with CorelSure Maintenance) can take advantage of
greater support for Microsoft SharePoint. New options
allow for the addition of a version description or
choice of a version type, such as a major or minor
version. Major versions (1.0, 2.0 and so on) can be
used for making important changes in a drawing,

whereas minor versions (1.1, 1.2, 1.3 and so on) can be
used for making light edits. In addition, depending on
how the permissions are set up in a document library,
a minor version might be treated as a draft document
that only certain users can access.

Be precise

When it comes to visually communicating how
something is designed, assembled or operates,
accuracy is paramount. CorelDRAW Technical Suite
2019 offers a range of precise illustration and design
tools to create detailed technical documentation with
exact specifications.

Enhanced! I1sometric drawing tools: Corel DESIGNER
takes the guesswork out of redefining a projected
drawing plane when there is no third axis available.
Instead of going through trial and error to customize a
drawing profile, technical illustrators can define the
active drawing plane interactively in just a few clicks.
The values of the X, Y, and Z axis are automatically
recalculated in the Projected Axes docker, and then
you can finish the job with any of the drawing tools.

Confidently draw on projected planes
using enhanced isometric drawing tools.

New! Line style sets: As more industries around the
globe adopt the S1000D standard to ensure content
quality and reliable information sharing, Corel
DESIGNER continues to extend its support for this key
technical illustration specification. S1000D-compliant
line style sets, including Thick Line, Medium Line, Thin
Line, Center Line or No Line, are now accessible from
the from the Objects Styles docker or can be applied
using keyboard shortcuts.

Click here to see how it works.
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New line style sets that support technical illustration standards.

Enhanced! Object style sets: Now when vector
illustrations are imported from XVL Studio Corel
Edition via its Send to Corel DESIGNER command, you
can create style sets from them with a single click in
the Object Styles docker. This functionality applies for
multiple curves imported from other sources, too. If
style sets that match the properties of the imported
curves already exist, they're applied to the curves
automatically. When you modify and re-import a
source model in a drawing, you can apply existing
matching styles to all curves, saving yourself the hassle
of applying styles to individual curves. In addition,
when creating an illustration from scratch, you can do
the same when applying style sets at any stage in the
design.

Give it a try

Create a line style set from an object

1  Inthe Welcome Screen, open the Discover file
Bike Parts.

If the Welcome Screen isn't open, click Help »
Welcome.

2 Using the Pick tool \ , right-click the chain.

3 Choose Object Styles, and point to New Style Set
From.

A preview shows you what object attributes will be
included in the new style set.

4 Click New Style Set From.

5 Inthe New Style Set From dialog box, type Chain in
the New Style Set Name box, and click OK.

In the Objects Styles docker, you can access the
new style set and apply it to other objects.

New! Arrows and dimension lines in projected drawing:

Another projected drawing enhancement delivers
better views of design components and more
expected results. Arrowheads (line ends) of dimension
lines and regular lines now project with the lines when
you draw on a projected drawing plane.

Add context with enhanced projected arrows.

New! Pixel-perfect workflow: A series of new features
take the guesswork out of creating crisper icons,
dashboard images, and web graphics. Enhanced pixel
snapping ensures clean results by automatically
positioning an object on the pixel grid based on its
properties. New page-alignment defaults and precise
pixel readouts help deliver sharp graphic edges and
better support for odd-pixel-number sized drawings.
This feature is also available in CorelDRAW 2019.

Refined pixel workflow tools guarantee pixel-perfect results.
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Be productive

No time or effort is wasted with this highly efficient
solution for technical design. Enjoy a seamless
workflow from opening 2D and 3D source files,
photos, documents and data, to producing and
publishing technical communications.

New! Objects docker: How users work with and
manage design elements, layers and pages has been
totally re-imagined in CorelDRAW Technical Suite
2019. The new Objects docker in Corel DESIGNER,
CorelDRAW and Corel PHOTO-PAINT lets you work
faster and smarter by giving you direct control over
the structure of a document and fast access to its
components.

An enhanced interface makes it easier to find parts of
your design. Object thumbnails update instantly to
reflect shape and color changes, effects, and
transformations to make it simpler to identify and
pinpoint design elements. In addition, you can
precisely resize object thumbnails in the docker. New
search functionality lets you filter and group design
elements by name. And to eliminate visual clutter, the
Lock and Hide buttons for each object only display
when hovered over.

In Corel DESIGNER 2019, new view modes allow you to
change what the Objects docker displays. This lets you
focus on what's most critical at that point in your
workflow, whether it's everything in the document,
only the active page, or just a list of pages in the
design. When working with complex projects, you can
use different views for different layers with a single
click, having objects on one layer display as wireframe
renderings and objects on another layer in color.

Working with layers in Corel DESIGNER 2019 is more
intuitive. Now when you select an object, the layer on
which it resides becomes the active layer, making
working with objects more predictable. Enhanced
drag-and-drop functionality makes it easier to group
and move objects from layer to layer and reorder
pages. Now with a single click, you can expand and
collapse pages, layers, and any grouped or nested
objects residing on them. And dealing with large files

created in other applications is never a problem
thanks to a new command that instantly deletes any
layer that doesn’t contain objects or text.

Click here to see how it works.

Gain insight into project elements and get more control
over the management of objects, layers and pages.

Give it a try

Work with objects

1 Inthe Welcome Screen, open the Discover file
Bike Effects.

If the Welcome Screen isn't open, click Help »
Welcome.

2 In the Objects docker, type bitmap in the Search
box.

If the Objects docker isn't open, click Window »
Objects or press Ctrl+F1.

The Content list is filtered to display the only
bitmap in the drawing.

3 Position your cursor over the bitmap in the Objects

docker, then click the Hide button (® a few times
to toggle the display of the bitmap.

4 In the Search box, type group to display only the
grouped objects in the drawing.

5 At the bottom of the Objects docker, drag the
Resize List slider to the right.

The icons for the grouped objects in the Content
list increase in size as you move the slider.

Enhanced! Projected Axes docker: It's easier than ever
to create and edit drawing profiles thanks to Projected
Axes docker enhancements. New labeled axis lines on
the interactive cube give you a clearer understanding
of how it relates to docker controls. The docker offers
new features that are more intuitive and streamline
projected drawing. Now you can set the active
projection plane with a click of a cube plane or return
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to orthographic mode by deselecting the cube,
accelerating workflows that call for intensive projected
drawing.

Click here to see how it works.

Labeled axis lines add clarity to the interactive cube.

New! Shortcut and modifier keys: Corel DESIGNER
2019 introduces new shortcut and modifier keys that
accelerate the workflow of some of the most
frequently used tools and features.

Splitting objects with the Knife tool is faster thanks to a
new shortcut (A) that lets you toggle between cutting
modes — 2-point line, Freehand, or Bézier.

When the Pick tool is active, a new modifier key (W)
lets you move an ellipse or an ellipse within in a group
along its thrust axis. You can also move other selected
objects together with the ellipse.

Another new keyboard shortcut (Ctrl+Shift+V) lets you
paste objects in the center of the viewable area of your
drawing so that you don't need to zoom out and pan
to find them.

Click here to see how it works.

Give it a try

Determine projected drawing planes interactively

1 Inthe Welcome Screen, open the Give it a try file
Create Projection.

If the Welcome Screen isn't open, click Help »
Welcome.

2 In the Objects docker, click the top object in the
Content list, scroll to the bottom of the list, hold
down Shift, and click the bottom-most object to
select all items in the list.

3 Right-click, and click Unlock.

4 Click Window » Projected Axes.

5 In the Projected Axes docker, enable the With 3
axes option, and click Define.

6 Click and drag over the group of objects in the top-
right of the illustration to define the Y, X, and Z axis
consecutively using the cube in the Projected Axes
docker as reference.

7 Use any of the drawing tools to draw on the
drawing plane you just defined.

Move an ellipse along its thrust axis with the
Pick tool

1 In the Objects docker, type ellipse in the Search
box.

Click the bottom-most ellipse, and click the Lock

button a to unlock it. In the drawing, the ellipse is
selected.

2 Click the Pick tool \ , hold down W, move the
cursor over the ellipse, and drag.

The ellipse is moved along its thrust axis or shortest
diameter.

You can also move a group along the thrust axis of
a specific ellipse in the group by selecting the
group with the Pick tool, holding down W, moving
the cursor over the ellipse, and dragging.

You can move an ellipse along its thrust axis
independently from the group, by Ctrl-clicking the
ellipse, holding down W, and dragging.

New! Find and Replace docker: Streamlining everyday
tasks in a range of technical-design workflows was
central in the development of Corel DESIGNER 2019.
To that end, how you find and replace objects and text
has been totally overhauled and simplified. The new
Find and Replace docker, which replaces the Find and
Replace wizard of previous versions, offers a
straightforward, intuitive interface that lets you locate
drawing components and change their attributes
faster than ever.

The new From Selected option lets you select an
object and use its type, outline, effects and fill as the
basis of a search. You can also search for Corel
DESIGNER object types such as thread shapes, well
shapes, cylinders, and prisms. A selected object’s
properties are displayed in the docker, and you can
choose which ones to use, allowing you to narrow or
broaden the search.
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Replacing object properties is a lot faster in Corel
DESIGNER 2019, too. To save time, multiple properties,
such as color, fill and outline, can be simultaneously
replaced. What's more, you can find an object and
replace properties even when it is part of a group, all
without compromising the group hierarchy of the
document. And finding and replacing text is enhanced
to include text in PowerClips and nested in grouped
objects.

This feature is also available in CorelDRAW 2019.

Save time finding drawing components
with the Find and Replace docker.

Enhanced! Technical lllustration workspace: If you
create technical graphics destined for any number of
deliverables — product manuals, engineering
publications, catalogs of interactive parts and more —
the updated Technical lllustration workspace will boost
your productivity in a couple of clicks. It puts
everything you need right at your fingertips, so you
can work faster and more efficiently. Corel DESIGNER
optimizes and reconfigures the user interface (Ul)

to conveniently position the toolbox to suit your
workflow and automatically display the dockers that
technical illustrators use the most. It also closes the Ul
elements that you're not likely to need, giving you
more screen space to work.

Enhanced! Performance: Because even a little lag
time gets in the way of your productivity, the
development team focused on making this release the
fastest version of the suite yet. Comprehensive
performance enhancements ensure that you can work
faster than ever — whether launching an app, working
with text, resizing Ul elements and much more.

Enhanced! Options workflow: The interface for
setting preferences has been reorganized, making it
quicker and easier to tailor your design environment.
The revamped Ul minimizes time spent searching for
controls and ensures it's clear whether changes affect
the entire suite, the active application, or the current
document. Corel DESIGNER 2019 also saves you time
by streamlining how you set the default behavior of
commonly used tools. In addition, you can quickly
access color management options for document
display and printing. This enhancement is also available
in CorelDRAW 2019 and Corel PHOTO-PAINT 2019.
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Advanced 3D CAD repurposing: XVL Studio 3D
CAD Corel® Edition (optional add-on)

For organizations that require additional 3D editing
capabilities and direct access to 3D CAD assembly
files, CoreIDRAW Technical Suite 2019 offers an
upgrade to XVL Studio 3D CAD Corel Edition. This
add-on provides native assembly and part file support
for 3D CAD systems used in discrete manufacturing,
such as the automotive, aerospace, and machinery
industries. XVL Studio 3D CAD Corel Edition lets users
do more with CAD files without the steep learning
curve of 3D CAD software. It streamlines the workflow
of technical communication professionals by reducing
the need to consult design engineers when preparing
graphics content.

XVL Studio 3D CAD Corel Edition enhancements

Process Design and Process Snapshot features:

A variety of workflow improvements accelerate 3D
CAD authoring. A new setting lets you select a part in
the Manufacture tree, then press the Tab key to select
the Manufacture assembly to which it belongs.
Another new option simplifies the registration of
multiple parts to a single task with a simple drag-and-
drop to the Process tree.

Now parts belonging to a task are automatically
shaded in the hidden line display mode. You can
automatically add callouts with specified string
formats to parts in a process or task. In addition, when
you readjust a viewpoint that contains existing notes
or markups, you can ensure that they remain visible
when rotating.

And to improve collaboration, you can export process
snapshots as image files. Process snapshots can also

be imported and exported, allowing multiple authors
to create and merge them into a single process tree.

Technical Illustration output: A new feature lets you
export high-resolution, hybrid vector and bitmap
output in a single step when using the Send to Corel
DESIGNER command. When a 3D view is exported,
you can now specify the resolution of shaded views,
which are bitmaps, included with the vector illustration
to ensure better scaling and high-quality printing.

Auto Detection and Update workflow: A new option
helps you ensure that matched parts are always
displayed in the same line between two lists,
guaranteeing synchronicity while scrolling. Another
new feature makes tracking parts easier than ever by
retaining the original part name in the Design Update
Property List, even if it changes. You can also search
for parts or tasks where part names have changed
during a design update. And in addition to having the
ability to use the Assembly tree to compare and match
parts, you now also use Manufacture trees.

XVL Studio Corel Edition enhancements

Selection and navigation: A series of new features
and enhancements save you time by making it easier
to select parts of a design and navigate drawing
components in XVL Studio.

You can use the arrow keys to navigate to a parts
folder tree and change selections. The Up and Down
arrow keys change the active folder. The Left arrow key
opens up a selected folder to display nested contents,
while the Right key collapses an expanded folder.
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The new Find Similar Attributes function lets you
quickly find parts that share similarities. By simply
choosing an attribute to use as the search criteria, you
instantly get a report of parts in your design that
match those properties.

Cross-section tools: Because time is so critical, XVL
Studio introduces cross-section workflow
improvements to boost productivity. To that end, you
can now click fill faces on the cross-section of a part to
highlight and select it. A new option helps you work
more efficiently by making it easier to distinguish the
profile lines and fill faces of cross-sections. You can
now choose different colors for profile lines and fill
faces, ensuring that they always stand out against
each other, so you can work faster than ever. In
addition, cuts in overlapping parts display fills as
expected and offer high-quality section views,
including when being sent to Corel DESIGNER as
vector illustrations.

Callouts: XVL Studio has enhanced callout (text note)
functionality that lets you work with precision. When
moving a 2D note, the end of the leader line is
displayed as the center of the string. This lets you
know the exact location of the 2D note in relation to
other design elements as you drag to reposition it.
You can resize images attached to 2D or 2D fixed
notes by dragging a corner handle on the graphic or
scaling it to a specific percentage of the original size.
Another enhancement is the ability to add information
to parts using pattern notes, which contain balloon
numbers for parts and attribute properties. This allows
you to concisely and quickly convey the most
important data about a part.

And when you quickly need to know how two parts in
a drawing measure up against one another, you can
use a comparing note. By simply selecting the two
parts and specifying what attributes to include in the
comparison, you get a snapshot of their differences
and similarities.

XVL Studio 3D CAD Corel Edition features

File support: XVL Studio 3D CAD Corel Edition
supports a broad range of native 3D CAD file formats.
such as assembly and part files from CATIA,
SolidWorks, PTC Creo Parametric (formerly Pro/
ENGINEER), Autodesk Inventor, NX, SolidEdge, and
more. It also supports 3D CAD exchange formats, such
as JT, IGES, STEP, and Parasolid. File import support

also includes CATIA V5-6R2018, Autodesk Inventor
2018, NX 12, Solid Edge ST10, SolidWorks 2018.

3D CAD file options: You can send multiple 3D views to
Corel DESIGNER as vector illustrations in one go.
What's more, you can resend newer versions of views
stored as snapshots to update existing illustrations in a
DES file. The Process Snapshot feature simplifies the
capturing and illustration of assembly and
maintenance processes. You also have the flexibility of
adding specific options from the standalone version of
XVL Studio, such as the Process PDF Template option,
to a XVL Studio 3D CAD Corel Edition license.

Update / replace assembly functionality:

Once a design moves to the production phase,
construction changes are common. With XVL Studio
3D CAD, you can update early designs at any time due
to changes determined by construction. Disassembly
views, animations, and other 3D authoring functions
are maintained, so that you can efficiently update
technical illustrations with the most current revision of
the manufacturing design.

The update or replace assembly functionality offered by XVL
Studio 3D CAD Corel Edition helps you ensure that the most
current manufacturing revisions are reflected at any time in
the visualization workflow.
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Update a 3D-sourced illustration: To speed up
technical-publication authoring, CorelDRAW Technical
Suite 2019 with XVL Studio 3D CAD Corel Edition
offers the Auto Detection and Update command. It
updates 3D visualizations created in XVL Studio CAD,
stored snapshots, cross-sections and animated
procedures — including process animations for
illustrating complex, multi-step assembly, disassembly,
or maintenance procedures — based on the
modifications applied to the CAD source data. New
selection, review and filter options in the auto
detection and update process automatically apply
modifications in Engineering files to all visualizations
created for technical communication.

It also lets you automatically generate updated vector
illustrations to replace ones in DES files that were
created using the Send to Corel DESIGNER command.
The illustration specifications, such as view, positions
of the objects, line weights and export settings, are
fully recognized and maintained. As a result, the
illustrations are recreated using the updated 3D model
and inserted in the same place as the original,
allowing technical illustrators to start a publication
with a preliminary 3D design and update it with the
final design instantly.

Evaluation tools: Before 3D models and data can be
used in downstream applications, the integrity of the
3D model requires validation. XVL Studio 3D CAD

provides assembly evaluation tools for geometry and

measurements, interference check, and collision
detection so you can quickly verify the integrity of a
3D assembly.
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Additional 3D CAD tools: With XVL Studio 3D CAD, you
can edit 3D models and combine 3D models from
different CAD sources. It provides a rich 3D CAD
toolset that lets you modify and transform 3D parts,
shapes, and assemblies.

Animation tool set: XVL Studio 3D CAD

provides a full set of animation tools, including a
dedicated editing console as well as a method for
automated creation of disassembly animations.
Process animations can be created to capture
complex, multi-step assembly or maintenance
procedures with detailed instructions. And new
options make it easier than ever to edit process
animations. The hierarchical structure of the Assembly
Tree view and the ability to create custom tree
structures for disassembly and process animations
gives you full control over the creation of assembly,
sub-assembly, and part structures for use in illustrated
assembly and maintenance instructions.
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Online and mobile outputs: XVL Studio 3D CAD
supports output of 3D models to HTML5 and for
mobile devices. By using the highly compressed XVL
file format, you can share complex models with
virtually anyone, using the free XVL Player as browser
plug-in for desktop/laptop or iXVL apps for iOS. XVL is
the most lightweight 3D format in the industry,
enabling data to be compressed to an average 0.5% of
its original size with high accuracy. For example, a 500
MB 3D CAD assembly file can be shared on mobile
devices as an XVL file with an approximate file size of
2.5 MB.

3D outputs: With XVL Studio 3D CAD Corel Edition,
you can output to various 3D file formats, including
3DS, DXF, IGES, OBJ, STL, U3D, and VRML. You can also
publish directly to 3D PDF from XVL Studio CAD Corel

Edition, using a PDF template with animation controls.
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About Corel

One of the world's top software companies, Corel offers some of the industry’s most respected and well-known
brands, including CorelDRAW®, Parallels®, MindManager®, ClearSlide®, Pinnacle”, and WinZip®. Across our entire
portfolio, Corel's products give today's knowledge workers the tools they need to achieve new levels of creativity,
productivity, and success.

For more information, please visit www.corel.com.
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